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Part I: Pre-activities for the classroom 

Science background 

 Corals are marine invertebrates in the class Anthozoa of 

phylum Cnidaria. They have a simple body structure (Figure 1) 

and like other cnidarians such as jellyfish, sea anemones, and 

zoanthids, they utilize nematocysts or “stinging cells” to catch 

potential prey (Figure 2).  Polyps feed in two ways: either by 

utilizing nematocysts in the polyp’s tentacles to capture 

zooplankton, or by using a symbiotic, single-celled algae that 

lives in the coral’s tissue called zooxanthellae to photosynthesize 

(Figure 3).  Like plants, zooxanthellae have internal structures 

called chloroplasts that are able to convert carbon dioxide and 

water, using sunlight, into sugar and oxygen. In return for food 

energy from the zooxanthellae, the coral provides shelter.  Corals 

exist in either solitary or colonial forms.  Solitary corals survive as a single, independent coral 

polyp.  Colonial corals, which are the structure most people think of when picturing a coral reef, 

consist of many polyp clones living communally, often sharing skeletal or digestive systems 

among polyps.   

Like all animals, corals reproduce to generate new offspring.  Coral larva (juvenile coral, 

Figure 4) are either genetically identical or genetically different from their parent(s) depending 

on the mode of reproduction. During sexual 

reproduction, corals combine sperm cells 

and ova (egg cells) to form zygotes.  If the 

fertilization occurs internally, allowing the 

female coral to house developing larvae until 

they are ready to metamorphose, the process 

is called brooding.  If the fertilization occurs 

externally, after the male and female corals 

release their gametes into the water column, 

the process is called broadcast spawning.  

 
Figure 1. Anatomy of a coral 

polyp.  (oceanservice.noaa.gov) 

 
Figure 2.  Schematic (A) and high-speed camera images 

(B) of a discharging nematocyst.  The charged (ready-to-

fire) nematocyst is on the left, the fully-discharged 

nematocyst on the right (Nüchter et al. 2006). 



 

Corals can also utilize asexual reproduction, 

which does not require an exchange of genetic material 

(i.e., no combination of eggs and sperm). 

Fragmentation occurs when a branch of coral breaks 

off the parent colony (as can often happen during a 

storm event).  The broken branch, under right 

conditions, reestablishes itself and becomes a new coral 

colony.  During budding, a new polyp develops, or 

buds off, from an outgrowth or mature polyp 

(Highsmith 1982). The new polyp separates from the 

parent polyp when it is mature.  The polyps created from fragmentation or budding are clones 

and genetically identical to the parent coral since there is no mixing of genetic material during 

reproduction.   

After fertilization and many rounds of cellular division occur, a free-swimming coral 

larva, called a planula (Figure 4), is able to start looking for a suitable place to settle and 

continue development. The planula is covered in many small hairs, called cilia, which are used 

for locomotion. Planula can also use their cilia to detect sounds and orient themselves to the 

source of the sound (Vermeij et al. 2010).  This is helpful for locating healthy reef environments 

which tend to be noisy with wave energy and animal activity. 

The planula has a set of sensory organs, called the apical sensory organs, which detect 

favorable chemical cues for settlement. These sensory organs are located on the aboral end of the 

planula, opposite of the region where the mouth is located. The apical sensory organs are located 

along the outer layer of skin on the planula along with nematocysts and other secretory gland 

cells. When a planula finds a suitable place to settle, it attaches to the surface, flattens out, and 

metamorphoses into a polyp (this first stage is also called a “spat,” Figure 5).  The polyp begins 

secreting a calcium-carbonite skeleton known as a calyx 

(Tran & Hadfield 2013).  As the polyp grows, buds, and 

continues secreting its rocky skeleton, it contributes to the 

growth of the reef structure. 

 

Importance of Coral Reefs 

Corals have a complex 3D structure with high 

rugosity, or roughness, to provide nooks and crannies that 

are used by marine animals as homes. This habitat is 

important for all types of small creatures that we rarely see 

(“cryptofauna”) including shrimp, crabs and worms, 

providing them a safe place to reproduce in addition to 

hiding from predators. Coral reefs are also important to the people of Hawaiʻi.  The reefs in 

Hawaiʻi contribute $800 million per year to the state’s economy, mostly from the tourist dollars 

that they attract to the islands (Davidson et al. 2003). Coral reefs are important in the dispersal of 

 
Figure 3. Coral polyp with clearly visible 

zooxanthellae (green structures in the clear 

coral tissue) (ocean.si.edu). 

 

Figure 4.  Coral planula observed at 100X 



 

wave energy making coral reefs important to homeland security during storms and tsunamis.  

There is also a strong cultural tie to coral in Hawaiian legends and coastal resource management. 

Other uses for corals include certain chemicals corals use to defend themselves from 

other corals. These chemicals have been found to have human application in fighting bacterial 

infections and cancer. Within this century, scientists have isolated chemicals secreted by corals 

to fight cancer (Rangell & Falkenberg 2015).  On a global scale, reefs have provided the optimal 

foundation for ports and harbors on all coasts. But impacts to reef health and structure from 

overuse by humans is taking its toll - as reefs die, shores are prone to storms, erosion, and wave 

action, in addition to straining the relationships corals have with other animals that depend on 

them for survival. All around the world, corals have adapted to their environments and their 

ecosystems, but a changing environment (which includes rising sea levels, increasing ocean 

temperatures, and ocean acidification) threatens these fragile relationships.   

  

Research at the Hawaiʻi Institute of Marine Biology 

Healthy coral colonies make up the 

foundation of any health reef ecosystem. Since these 

animals play such an important role to a wide 

variety of organisms, both marine and terrestrial, 

there are many labs at HIMB that are dedicated to 

furthering our understand of individual coral 

formations, their interactions within a reef 

ecosystem, the human applications that can be 

derived from corals, and the damage that humans 

have caused to these organisms. The Karl Lab looks 

at coral resilience on a small scale and investigates the factors that impact possible microhabitats 

present on an individual coral. The Toonen-Bowen Lab examines the larger scale relationships 

within a coral reef ecosystem by assessing a variety of factors that impact reef invertebrates and 

fish. The Hagedorn Lab investigates cooling rates of coral gametes, cooling rates of symbiotic 

algae and cryopreservation of coralline genetic material for future studies and conservation. . The 

Point Lab was instrumental in understanding the biochemical mechanisms behind ocean 

acidification and corals. The Point Lab designed flumes that were able to mimic future oceanic 

conditions and provide key insights into understanding the chemical processes and mechanics 

behind ocean acidification 

Dr. Ruth Gates is the principal investigator of the Gates Lab and has been working with 

researchers and graduate students to investigate attributes in corals that determine differences 

and sensitivity in their ability to adapt to thermal stress, ocean acidification and anthropogenic 

pollution. The Gates Lab’s main focus is on early coral resilience, settlement, and development 

and the breeding of so-called “super corals”. “Super corals” are naturally occurring coral species 

that are more adaptable to environmental changes and better suited to a climate that has shifted 

towards more acidic conditions. By looking at larval coral responses to conditions that mimic 

 
Figure 5.  A coral “spat” (settled coral after 

metamorphosis, left) and coral planula (right). 



 

future ocean conditions, the scientists in the Gates Lab are able to examine the genes that make 

corals most resilient in the face of a changing climate. Additionally, the Gates Lab studies the 

correlation between the abundance of zooxanthellae and their impact of coral recruit growth.  

 

Classroom Laboratory:  

Background Research 

Researchers do a considerable amount of preliminary investigation by reading previously 

published results in order to become more informed of the latest information on a particular topic 

area. There is already a considerable amount of information available and accessible on the 

internet. Before their field trip to HIMB, students should do their own background research and 

become more familiar with the key concepts of reproduction mechanisms in coral, how corals 

choose suitable places for settling, and how changing environmental conditions affect a polyp’s 

ability to survive. The following links can provide a starting point for students’ research:  

http://www.icriforum.org/about-coral-reefs/what-are-corals 

http://oceanservice.noaa.gov/education/kits/corals/coral06_reproduction.html 

http://oceanservice.noaa.gov/facts/coralreef-climate.html 

 

Classroom activities 

Below is a classroom activity designed to help students become familiar with the complex 

ways corals reproduce and form new reef structures.   One important theme to keep in mind is 

how human changes to the environment affect coral’s ability to settle and undergo 

metamorphosis into the conventional coral form we are familiar with.  The exercise will try to 

instill in students the difficulty of a coral larva’s journey from planula to adult coral.  

1. One recommended classroom activity is for the students to research and illustrate the 

different modes of coral reproduction. The diagrams drawn by students should include 

depictions or descriptions of budding, brooding, fragmentation, and broadcast 

spawning.  Students may also outline the differences between sexual reproduction and 

asexual reproduction and list any specific species of coral that use a certain mode of 

reproduction.  

a. Items needed: 

i. Research materials (computers, books, journal articles) 

ii. Posterboard and markers 

 

  

http://www.icriforum.org/about-coral-reefs/what-are-corals
http://oceanservice.noaa.gov/education/kits/corals/coral06_reproduction.html
http://oceanservice.noaa.gov/facts/coralreef-climate.html


 

Part II: Field trip day at HIMB 

Introduction 

In this activity, students will be scanning terracotta tiles to collect qualitative and quantitative 

data on coral recruitment and growth in different environments.  These tiles will be retrieved 

from different spots around Moku o Loʻe that each have unique environmental conditions 

varying in temperature, turbidity, human activity, pH, and salinity. Instructors will also collect 

water quality data at these tile sites before students arrive.   

 

Once the students arrive in the classroom at the Marine Science Research Learning Center at 

HIMB, they will separate into groups of four, be assigned two coral settlement tiles, and make 

predictions on coral polyp health based on previous data and water quality. Each group will 

measure coral larval health, settlement, and growth by recording the number of recruits found on 

the tile that day and by taking pictures of coral colonies on digital microscopes. The pictures 

taken will be analyzed on open-source, digital imaging software (ImageJ, NIH) in which the 

exact area and number of polyps comprising each coral colony can be determined. Once the data 

is collected, students will add their data to a collaborative  database documenting coral health in 

Hawaiiʻs marine ecosystems. 

 

Tools Available 

● Coral tiles 

● Pipette(s) 

● Graduated beakers 

● Petri dishes 

● Filtered sea water 

● Digital microscopes (Celestron, MicroCapture Pro) 

● Micro-Scaling tool 

● Laptops w/ImageJ software 

 

Materials to bring to HIMB 

● Writing utensil 

● Paper/Notebook 

 

HIMB Classroom Laboratory Activity 

Procedure 

The instructors will retrieve the coral settlement tiles and record water quality data using field 

pH meters to measure acidity or basicity and refractometers to measure salinity. They will also 

record any other observations about the tile sites (e.g., whether runoff from previous heavy 

raining is present at tile collection site) to provide environmental information for the students. 

Each pair of students will record the number of coral recruits on one tile using a Celestron 



 

Digital Microscope and an orthographic chart of a tile (See Appendix A for orthographic chart).  

To collect data, students should do the following: 

 

1. Gently place a settlement tile in a petri dish with 

sea water. Use the bulb pipette to occasionally 

rehydrate the surfaces that are not submerged in 

seawater.  

2. Record the placement of each coral colony of the 

tile on the orthographic chart.  You can use the  

digital scope or hand magnifying glass to help you 

zoom on areas.  

3. After a coral colony has been found, take a picture 

of the colony on the laptop using the digital scope 

with the micro-scale tool in the picture. Make sure 

that the micro-scale tool is in the image, the 

colony/spat is in the center of the image, and take one picture for each colony/spat.  

This step is crucial in being able to determine the correct scale of the colony in ImageJ.  

4. Save the picture to the desktop with the file name generated on your Excel sheet (e.g., 

20170315-PL201-C6.png).  These tiles can be difficult to handle while taking pictures so 

make sure to work in pairs, where one student handles the tiles and the other student 

handles the computer. 

5. Count the number of polyps you see for the colony.  Note the health condition of the 

polyps (healthy, bleached, dead, or other).  Next, we will measure the area of the colony. 

 

Once you have recorded all the colony locations on the orthographic chart and have saved the 

digital pictures taken on the desktop, you are going to analyze the pictures with ImageJ. 

A. Click on the ImageJ icon ( ).  You will see a small ImageJ toolbar appear. 

B. Go to File>Open (or, command+O) and then select the first picture to be analyzed from 

the desktop. 

C. Select the *Straight* line tool in the toolbar ( ).  Click, drag and release to draw a 

straight line between two of the numbered ticks (e.g., the 0 (zero) and 1 millimeter 

notches) on the ruler in the picture. 

D. Go to Analyze>Set Scale... 

a. In the pop-up box, in the Known Distance box enter “1” (because the line is 1mm 

long). 

b. In the Unit of Length box, enter in unit used (mm), then hit “OK” 

E. Go to Analyze>Set Measurements... 

a. In the popup-box, check off Area, then hit “OK” 

 

Figure 6. Coral settlement tile in water 

and bulb pipette.  Notice the tile 

orientation with the “chip” off the tile in 

the upper right hand corner. 



 

F. Select the Freehand selections tool ( ) and carefully trace the perimeter of the coral 

colony 

G. Go to Analyze>Measure (command+M) 

H. A data window will be displayed with your coral area measurement in the unit you 

specified (mm2).  Record the area of the colony on your datasheet. 

I. Repeat steps B-I for each additional coral colony/spat picture. 

 

Once each picture has been analyzed, students will add their data to previous students’ data using 

the provided Excel data sheet.  After all the students have added their data to the database, the 

instructor will share the class’s results and compare it with previously collected data. 

 

After recording their observations, the students will discuss and make predictions on the coral 

colony health based on certain water quality conditions.  This laboratory exercise is an example 

of descriptive research, used by scientists to generate hypotheses.  After collecting growth data 

from their coral tiles, the students will be encouraged to generate their own research 

questions/hypotheses.  Below are some questions to help guide students towards the important 

factors that might affect coral settlement and survival: 

 

Guiding Questions 

1. How is climate change and human interaction affecting Hawaiʻi’s marine environments? 

2. What factors influence where a coral will settle? 

3. What types of resources does a coral need to compete for?  Who are coral’s main 

competitors for resources on the reef? 

4. Are coral and zooxanthellae (the algae that live in coral) both affected equally by 

environmental changes?  What types of changes affect them the most? 

5. What environmental factors affect how quickly a coral can grow?  Can the same species 

have different growth rates in different environments? 

6. Do “natural” environmental changes (e.g., seasons, storms, animal migrations) affect 

coral reefs more than anthropogenic changes (e.g., pollution, boat activity, ocean 

acidification)? 

 

 

 

 

 

 

  



 

Part III: Post-activities back in the classroom 

A critical part of the scientific process is being able to analyze and interpret your data, and then 

communicate your findings with both the scientific and general public communities.  Once back 

in your home classroom, you will discuss your data with your labmates and can further examine 

the larger coral growth data set available online to compare with your findings.  After a research 

project, scientists work hard to publish a written report and/or present their experiment at a 

regional, national, or international conference meeting.  Being able to effectively communicate 

research to a broad audience allows you to successfully contribute to our current understanding 

of the natural processes of our world. 

 

Begin class with a general discussion of your experience at HIMB. Were you prepared for the 

lab exercise and able to complete the activity? Did you enjoy your time there? Now begin to 

discuss the subject matter: 

 

A) Did your group discussions before doing the lab reflect what was seen on each of your 

tiles? If not, why do you think your presumptions did not align with what was seen at the 

tile site?  

B) Did you notice if there were any environmental conditions or combinations of conditions 

that killed the coral colonies? Did coral planulae settle on certain parts of the tile more so 

than other sides?  

C) Did you notice other organisms growing on the tiles?  

D) Do your findings influence the way you view the ocean? Will it change your behavior in 

terms of reducing your carbon footprint?  

 

Lab Report 

Written or oral lab reports are a good way to interpret your data, and share the story of your 

research.  For your laboratory exercise at HIMB, you will be expected to eventually provide an 

in-depth laboratory report that should include the following independent sections: 

 

● Title: summarize the entire experiment in several words. 

● Introduction: in one half to three-quarters of a page describe the lifecycle of coral 

polyps, how coral settle to form new reef structures, as well as how humans and climate 

change are affecting coral larvae, and why we should care. 

● Materials and Methods: develop and describe, in detail, the observations you 

conducted; include all of the materials you used to complete it as well. 

● Results: compile your data and express them visually and where appropriate in graphs, 

tables, or figures. 

● Discussion (including generated hypotheses/research questions): analyze your data in 

essay form; discuss the results, emphasize what did and didn’t work, and propose a new 

experiment or changes to your original experiment which may help explain the results; 

discuss the research questions or hypotheses generated by your observations. 



 

● Conclusion: in a paragraph or so, summarize your results and make concise conclusions 

about them; also include a sentence or two conveying your general conclusions about 

your results  

 

NOAA Data in the Classroom: Investigating Coral Bleaching 

For further discussion about factors affecting coral reef health and survival, the National Oceanic 

and Atmospheric Administration (NOAA) offers a free, interactive data analysis module 

focusing on coral bleaching (https://dataintheclassroom.noaa.gov/content/coral-bleaching).  The 

module, which includes additional slide presentations, data, lesson plans, and worksheets, 

describes in greater detail the threats faced by corals worldwide.   

 

Beyond the Classroom 

Scientists need to recognize the importance of their work outside of the laboratory.  Although 

gaining knowledge just for knowledge’s sake can be fun, research should have a practical 

application to humanity and the world at large.  After completing these laboratory exercises, we 

hope your students are more aware of some of the issues facing their community in light of 

global climate change.  Hawaiʻi boasts a unique and biodiverse environment that is particularly 

threatened by increasing temperatures and rising sea levels.   

 

Students should brainstorm ways in which they might be able to raise awareness about the issues 

facing corals, or observe or monitor changes in their local environment.  Students could host an 

activity week or produce a video or presentation on the importance of corals in Hawaiian culture.  

For science fair projects, students could monitor changes in coral bleaching over time, human 

use and activity at different beaches, or compare bleaching at different sites around their island.  

There are also volunteer opportunities such as beach cleanups, invasive algae removals, or 

watershed restoration projects.  Even at home, students could be encouraged to turn off lights or 

use less water.  Interviews with local kupuna to learn about traditional practices in caring for the 

marine environment could also help students strengthen their sense of responsibility to their 

community.  

 

For more information on Hawaiian community coastal resource management, the Department of 

Land and Natural Resources offers a community guidebook. 
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Appendix A: Coral Orthographic Growth Chart 

 

Date : __________________________ 

 

School: _____________________________________________________ 

 

Tile ID: __________________________ 

Environmental Data 

              

pH: ________ Temperature (C˚):  _________  Salinity (ppt): __________ 

 

 

 

A 
C 

B 

D 

E 



 

Appendix B: Relevant Next Generation Science Standards 

 

Performance Expectations: 

HS-LS2-6 Ecosystems: Interactions, Energy, and Dynamics 

● Evaluate the claims, evidence, and reasoning that the complex interactions in ecosystems 

maintain relatively consistent numbers and types of organisms in stable conditions, but 

changing conditions may result in a new ecosystem. 

HS-LS2-7 Ecosystems: Interactions, Energy, and Dynamics 

● Design, evaluate, and refine a solution for reducing the impacts of human activities on the 

environment and biodiversity.* 

 

Science and Engineering Practices: 

Scientific Knowledge is Open to Revision in Light of New Evidence 

● Most scientific knowledge is quite durable, but is, in principle, subject to change based 

on new evidence and/or reinterpretation of existing evidence. 

Engaging in Argument from Evidence 

● Evaluate the claims, evidence, and reasoning behind currently accepted explanations or 

solutions to determine the merits of arguments. 

Planning and Carrying Out Investigations 

● Plan and conduct an investigation individually and collaboratively to produce data to 

serve as the basis for evidence, and in the design: decide on types, how much, and 

accuracy of data needed to produce reliable measurements and consider limitations on the 

precision of the data (e.g., number of trials, cost, risk, time), and refine the design 

accordingly. 

Scientific Investigations Use a Variety of Methods (Nature of Science) 

● Scientific inquiry is characterized by a common set of values that include: logical 

thinking, precision, open-mindedness, objectivity, skepticism, replicability of results, and 

honest and ethical reporting of findings. 

Analyzing and Interpreting Data 

● Apply concepts of statistics and probability (including determining function fits to data, 

slope, intercept, and correlation coefficient for linear fits) to scientific and engineering 

questions and problems, using digital tools when feasible. 

Obtaining, Evaluating, and Communicating Information 

● Communicate scientific information (e.g., about phenomena and/or the process of 

development and the design and performance of a proposed process or system) in 

multiple formats (including orally, graphically, textually, and mathematically). 

 

Disciplinary Core Ideas: 
LS2.C: Ecosystem Dynamics, Functioning, and Resilience 

● A complex set of interactions within an ecosystem can keep its numbers and types of 

organisms relatively constant over long periods of time under stable conditions. If a 

modest biological or physical disturbance to an ecosystem occurs, it may return to its 

more or less original status (i.e., the ecosystem is resilient), as opposed to becoming a 

very different ecosystem. Extreme fluctuations in conditions or the size of any 

population, however, can challenge the functioning of ecosystems in terms of resources 

and habitat availability. 

http://www.nextgenscience.org/pe/hs-ls2-6-ecosystems-interactions-energy-and-dynamics
http://www.nextgenscience.org/pe/hs-ls2-7-ecosystems-interactions-energy-and-dynamics
http://www.nap.edu/openbook.php?record_id=13165&page=59
http://www.nap.edu/openbook.php?record_id=13165&page=59
http://www.nap.edu/openbook.php?record_id=13165&page=59
http://www.nap.edu/openbook.php?record_id=13165&page=59
http://www.nap.edu/openbook.php?record_id=13165&page=59
http://www.nap.edu/openbook.php?record_id=13165&page=59
http://www.nap.edu/openbook.php?record_id=13165&page=61
http://www.nap.edu/openbook.php?record_id=13165&page=61
http://www.nap.edu/openbook.php?record_id=13165&page=61
http://www.nap.edu/openbook.php?record_id=13165&page=61
http://www.nap.edu/openbook.php?record_id=13165&page=74
http://www.nap.edu/openbook.php?record_id=13165&page=74
http://www.nap.edu/openbook.php?record_id=13165&page=74
http://www.nap.edu/openbook.php?record_id=13165&page=74
http://www.nap.edu/openbook.php?record_id=13165&page=154
http://www.nap.edu/openbook.php?record_id=13165&page=154
http://www.nap.edu/openbook.php?record_id=13165&page=154
http://www.nap.edu/openbook.php?record_id=13165&page=154
http://www.nap.edu/openbook.php?record_id=13165&page=154
http://www.nap.edu/openbook.php?record_id=13165&page=154
http://www.nap.edu/openbook.php?record_id=13165&page=154
http://www.nap.edu/openbook.php?record_id=13165&page=154


 

LS4.D: Biodiversity and Humans 
● Biodiversity is increased by the formation of new species (speciation) and decreased by 

the loss of species (extinction).  

● Humans depend on the living world for the resources and other benefits provided by 

biodiversity. But human activity is also having adverse impacts on biodiversity through 

overpopulation, overexploitation, habitat destruction, pollution, introduction of invasive 

species, and climate change. Thus sustaining biodiversity so that ecosystem functioning 

and productivity are maintained is essential to supporting and enhancing life on Earth. 

Sustaining biodiversity also aids humanity by preserving landscapes of recreational or 

inspirational value.  
LS2.D: Social Interactions and Group Behavior 

● Group behavior has evolved because membership can increase the chances of survival 

for individuals and their genetic relatives. 

 

Crosscutting Concepts: 
Cause and Effect 

● Empirical evidence is required to differentiate between cause and correlation and make 

claims about specific causes and effects. 

 

Common Core State Standards Connections: 

ELA/Literacy 

RST.11-12.1: Cite specific textual evidence to support analysis of science and technical texts, 

attending to important distinctions the author makes and to any gaps or inconsistencies in the 

account. (HS-LS2-2) 

WHST.9-12.2: Write informative/explanatory texts, including the narration of historical events, 

scientific procedures/ experiments, or technical processes. (HS-LS2-2) 

RST.11-12.7: Integrate and evaluate multiple sources of information presented in diverse formats 

and media (e.g., quantitative data, video, multimedia) in order to address a question or solve a 

problem. (HS-LS2-6) 

WHST.9-12.7: Conduct short as well as more sustained research projects to answer a question 

(including a self-generated question) or solve a problem; narrow or broaden the inquiry when 

appropriate; synthesize multiple sources on the subject, demonstrating understanding of the 

subject under investigation. (HS-LS2-7) 

WHST.9-12.9: Draw evidence from informational texts to support anafalysis, reflection, and 

research. (HS-LS4-4) 

  

Mathematics  

MP.2: Reason abstractly and quantitatively. (HS-LS2-2) 

HSN.Q.A.3: Choose a level of accuracy appropriate to limitations on measurement when 

reporting quantities. (HS-LS2-2) 

http://www.nap.edu/openbook.php?record_id=13165&page=166
http://www.nap.edu/openbook.php?record_id=13165&page=166
http://www.nap.edu/openbook.php?record_id=13165&page=166
http://www.nap.edu/openbook.php?record_id=13165&page=166
http://www.nap.edu/openbook.php?record_id=13165&page=166
http://www.nap.edu/openbook.php?record_id=13165&page=166
http://www.nap.edu/openbook.php?record_id=13165&page=166
http://www.nap.edu/openbook.php?record_id=13165&page=166
http://www.nap.edu/openbook.php?record_id=13165&page=166
http://www.nap.edu/openbook.php?record_id=13165&page=166
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